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5 Advanced Excel Pivot Table Techniques. Keep reading for a walkthrough of how to use each of these five features in
the written tutorial below, covering: Slicers, Timelines, Tabular View, Calculated Fields, and Recommended PivotTables.

Display datasets in a more logical output e. The output of this arrangement looks like the following: What if
you needed to provide a look at units sold by item for all the locations? This gives you a brand-new
perspective on the data. Then you will be able to select all available entries in the filter in whatever
combination you need. It gives you the average number of products sold. Then display that as the value. In this
case, this translates to the number of transactions or rows in our original data. Performing this action on the
example data yields the following: But it will ignore not count any entries with a value it has already
encountered. Only one is unique. For instance, if you wanted to count how many types of an Item was sold in
each month at each location. Grouping Still using the above example, the fields have been set up. What if you
no longer want to see it monthly, but want to see the data organized into financial quarters? In this case, we
will group April, May, and June. This will display a new column preceding it with a defaulted group name.
Doing this for the remaining months splits them into quarters as follows: Now, this operation has achieved the
technical task of grouping the data. To rename the separate group entries, click on their cell and replace the
text. This displays the table with collapsed groupings: This bonus is based on the number of units sold each
month. Select the Pivot Table. Experiment using different operations and using different fields to see what is
possible. Then display them in the desired way. Namely, view the results that comprise the given value entry
on the table. The operation of drilling counters this. Instead, every record associated with that field entry is
displayed. This will drill that data point to gather all its associated entries. These will then be displayed in
another sheet by default: This is a way of backtracking to the original data. You now have an auto-generated
list of entries for this data point. For example, you use a Pivot Table to create a report from a set of sales data.
Although a Pivot Table is powerful, you still have plenty of uses for other formulas in Excel. Sometimes,
these formulas refer to data inside a Pivot Table. This function glues together the references and the cell they
are referring to. As opposed to other functions, all you need to do is to click a cell. Start a formula in cell G5.
Type the equal sign and click a cell with data within the Pivot Table. It will look like this: This is the syntax of
the function:
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Pivot Table Tutorial Part 4 - Advanced Pivot Table This page provides a step-by-step guide of how to create an
advanced pivot table in Excel. Note that the directions on this page apply to current versions of Excel ( and later).

Start free trial Picture this: Your boss just sent over a massive Excel file. It has hundredsâ€”or maybe even
thousandsâ€”of rows of data. And, to make things worse, within all of those digits he would like you to find a
very specific trend or piece of information. Is your head spinning? Are your eyes glazing over? Staring at all
of those rows, columns, and numbers is overwhelming. What is a Pivot Table? Put simply, a pivot table
summarizes your data. It empowers you to extract significant trends or findings from what is otherwise a
totally overwhelming spreadsheet. Check out this video to see all of the different capabilities of an Excel pivot
table: How to Build a Pivot Table: A Case Study You get itâ€”pivot tables are awesome. Well, have no fear!
Jason brews and sells craft beer in a quaint brewery in his hometown. In order to better manage his inventory
and brewing schedule, he wants to see if there are any trends in terms of the type of beer that sells most each
quarter. For example, do people drink more dark beer in the wintertime? Getting a better grasp on any
seasonality would help him a lot, but to start he only has a spreadsheet that breaks down his sales of each type
of beer stout, pilsner, IPA, and an amber per quarter in and Want a quick way to check if there are any
spelling errors? Obviously, this tip works best for more manageable data sets. So, make sure those are in place
before you get started! You have two options: So, Jason is going to go ahead and choose to put his pivot table
in a new worksheet. In this step, you need to select the data that you want to pull into your pivot table. To pull
them into the pivot table, Jason will simply drag them into the appropriate spots for rows, columns, and
values. Will be your identifiersâ€”the different ways that you could ID the data. Do Your Analysis Now, your
pivot table will be populated. Before rolling up your sleeves and diving into the analysis, this is a good
opportunity to double-check things. Are you seeing all of the elements that you selected? Does anything look
off to you? For example, Jason can see that he sells far more stouts which is a darker, heavier beer in the first
and fourth quartersâ€”which makes sense, as those are the colder months. In contrast, he sells way more
pilsners a lighter, crisper beer in the second and third quartersâ€”which are the warmer months. Now, he can
leverage the information he discovered through his pivot table to better map out his brewing schedule and
manage his inventory of craft beer. Is your thirst not quenched with our beer example? Ready to Get Started?
Eager to learn more? Sign up to our Pivot Tables Course to discover even more tips and tricks that you can use
to leverage this powerful tool to your advantage. Download your free excel spreadsheets to practice Enter your
email address Loved this? Subscribe, and join , others. Get our latest content before everyone else. Your email
address Kat Boogaard Kat is a writer specializing in career, self-development, and productivity topics. When
she escapes her computer, she enjoys reading, hiking, golfing, and dishing out tips for prospective freelancers
on her website.
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Source Data for a PivotTable. You can change the range of the source data of a PivotTable. For example, you can
expand the source data to include more rows of data. However, if the source data has been changed substantially, such
as having more or fewer columns, consider creating a new PivotTable.

Excel Pivot Tables help you take a table or list of data and then create a report from it, instantly. How to
Create a Pivot Table in Excel? Creating a pivot table in Excel is very simple. Just follow these steps. Arrange
your data in a table like fashion. Make sure there are no blank rows. Video Tutorials on Pivot Tables You can
see a tutorial on pivot tables on the top of this page to the right. You can see the tutorial here too. Keep these 5
tips in mind next time you are using Pivot Tables. Click on the links to view the tip in detail. Drill down pivot
tables: You can drill-down and get details by just double clicking on a value. Change Summary from Total:
You can change summaries in Pivot Reports from Total to Count, Average or something else very easily. Just
use Value Field settings. You can move anything to anywhere in pivot reports and Excel would instantly
change the report layout and calculations. Difference from last month: You can easily display the difference
from last month by changing value field settings. Calculated Fields in Pivots: You can make custom
calculations in Pivot Reports by adding adding calculated fields. Click here to read all these tips in detail.
Advanced Pivot Table Techniques There are many things we can do with Pivot Tables to analyze data or do
complex reporting. Go thru these advanced pivot table techniques to learn more. Or, create show summaries
by hour from a transaction data etc. The possibilities are many. Learn more about grouping dates in pivot
reports. Learn more about pivot table report filters. Use Slicers to create interactive dashboards in Excel In
Excel , Microsoft has introduced a feature called as slicers. Think of slicers as filters, only more visual. So, if
you add a slicer for department, you would see the list of all departments in box. We can use this feature to
create an interactive dashboard in Excel, like below.
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2 A pivot table that contains multiple fields as data items, often displaying data being summarized using different
function operators. As part of this tutorial exercise, you will gain experience building pivot tables, starting with simple
pivot tables and.

They allow you to easily summarise, examine and present a complex list of data. This blog post explores 5
advanced PivotTable techniques. Grouping fields by month and year Calculating data as a percentage of the
total Using Slicers Applying Conditional Formatting to PivotTable data Creating calculated fields If you
prefer, you can skip to the video. If you are new to PivotTables, check out our introduction to PivotTables
tutorial. A common reason to do this is to group date and time fields. For example, to group by week, hour or
as I will demonstrate in this tip by month and year. Move the Date field you want to group by to the desired
area of the PivotTable. Right mouse click on a cell in the PivotTable that contains a date and select Group.
Select the Months and Years fields and click Ok. You can change the function being applied, but what you
may not know is that you can also change the calculation type for a data field. A common example of doing
this would be to calculate the data as a percentage of the total. So you could view the sales by a sales rep as a
percentage of the total sales. Right mouse click on one of the values in the table and select Value Field
Settings from the shortcut menu. Click the Show Values As tab. The values are changed to show the sales as a
percentage of the total. Using Slicers Slicers were introduced in Excel They provide a nice visual way of
applying filters to PivotTables. Their greatest benefit is that they can be connected to multiple PivotTables. To
filter multiple PivotTables at the click of a button is a fantastic skill for reporting dashboards. Click the Insert
Slicer button. Select a field to use for the slicer and click Ok. You can now filter the PivotTable by clicking on
one of the options in the slicer Hold down Ctrl to select multiples. It changes colour to identify the filter
currently applied. Click the red x in the corner to clear the applied filters. If you have more than one
PivotTable that you want to filter with the Slicer. Click the Report Connections button. Select the PivotTables
that you want to connect the Slicer to and click Ok. Creating a Calculated Field You can create your own field
in a PivotTable that performs calculations using the values of other fields in the PivotTable. These custom
fields are known as calculated fields. Click on the Analyze tab of the Ribbon Options in Excel and Enter a
Name for the field. Write the formula to perform the calculation. Double click a field from the list below to
use it within the formula. Click Ok and the new field is created and added to the PivotTable. And the great
news is that it can be applied to values in a PivotTable. The steps below will apply data bars to the sales
figures in the table. This will create a nice visual element for comparing the values. Highlight the values in the
PivotTable. Click the Conditional Formatting button on the Home tab. Select Data Bars and then choose the
Fill that you want to use.
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To pull them into the pivot table, Jason will simply drag them into the appropriate spots for rows, columns, and values.
There are obviously exceptions to this rule, but when you're just getting started, this is a good way to think about each of
these things.

For example, you can expand the source data to include more rows of data. However, if the source data has
been changed substantially, such as having more or fewer columns, consider creating a new PivotTable. The
current Data Source is highlighted. Change to a Different External Data Source. If you want to base your
PivotTable on a different external source, it might be best to create a new PivotTable. If the location of your
external data source is changed, for example, your SQL Server database name is the same, but it has been
moved to a different server, or your Access database has been moved to another network share, you can
change your current connection. A window appears showing all the Existing Connections. In the Show box,
keep All Connections selected. All the Connections in your Workbook will be displayed. Go through the Data
Connection Wizard Steps. Alternatively, specify the File name, if your Data is contained in another Excel
Workbook. The entire PivotTable will be selected. To do this, follow the steps given below. You get a
warning message, saying that you cannot Undo Delete and might lose some data. Since, you are deleting only
the PivotTable Sheet you can delete the worksheet. The PivotTable worksheet will be deleted. Using the
Timeline A PivotTable Timeline is a box that you can add to your PivotTable that lets you filter by time, and
zoom in on the period you want. This is a better option compared to playing around with the filters to show the
dates. It is like a slicer you create to filter data, and once you create it, you can keep it with your PivotTable.
This makes it possible for you to change the time period dynamically. An Insert Timelines Dialog Box
appears. The timeline for your PivotTable is in place. The four time levels will be displayed. The Timeline
filter changes to Quarters. The Timespan Control is highlighted. The PivotTable Data is filtered to Q1 At any
point of time, to clear timeline, click on the Clear Filter button. The timeline is cleared as shown in the image
given below. You can even create a PivotChart that is recommended for your data. Excel will then create a
coupled PivotTable automatically. The Insert Chart Window appears. The charts with the PivotChart icon in
the top corner are PivotCharts. A Preview appears on the Right side. Your standalone PivotChart for your
Data is available to you.
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About the Tutorial Advanced Excel is a comprehensive tutorial that provides a good insight into the latest Excel - Pivot
Table Tools.

The file used in this tutorial can be downloaded to follow along. Download the learn Pivot Tables tutorial file.
Excel Pivot Tables are a powerful reporting tool in Excel that allow you to easily organise and summarise a
large list of data. They can make analysing even the most complex list of data like a walk in the park. At first
they can seem quite daunting, but fear not, because once you have created your first one you will see that they
are very easy and user friendly to use. To create a Pivot Table: Select the range of cells you want to use for the
Pivot Table. Click the Insert tab on the Ribbon and then the PivotTable button. The Create PivotTable
dialogue box appears. If the range is not correct, select the data range you wish to use again. Decide whether
you want the Pivot Table to appear in a new worksheet or within an existing worksheet. The Add this data to
the Data Model checkbox is a new feature to Excel It is an advanced area of Pivot Tables where you can
related data tables and is not covered in this tutorial. Specifying PivotTable Data To specify the data to use in
the Pivot Table, you need to move the required fields into the relevant report areas at the bottom of the field
list. By simply moving the fields between the different report areas you change the configuration of the report,
and is why they are known as Pivot Tables. Click the checkbox for the Product Category field and Excel will
move it into the Rows area. Click the checkbox for the Total Sales Value field and it will be moved into the
Values area of the field list. The Values area is where the calculations are performed. By default, the Sum
function is used on any field containing numbers. We will look at changing this calculation later in this
tutorial. The Pivot Table displays the total sales by each category. Clicking a checkbox always puts a label
field into the Rows area. So for more control you can drag a field into the appropriate area instead. The
PivotTable will look like below with subtotals for the sales by category, and then a sum of those sales by sales
rep. Click and drag the Product Category field below the Sales Rep Field to change the order of the groupings.
Finally, click and drag the Product Category field into the Columns area. This will create a nice crosstab report
with sales rep totals along a row, and product category totals down the columns. It can take some practice to
get more familiar with PivotTables, and the more you use them the better you will understand them and very
quickly manipulate data and generate your reports. A Pivot Table summarises values using the Sum function
by default. However, instead of totals you may wish to know the number of orders taken, or the average
amount of those orders. To change a Pivot Tables calculation: Choose the function you wish to use from the
list on the Summarize by tab. Click Ok You can sort and filter the data in a Pivot Table much like you would a
normal data range. To use this filter, you first need to drag a field into the Report Filter area. Click and drag
the Country field into the Report Filter area. This field will appear above the PivotTable on the worksheet.
Click the filter list arrow and select the required criteria. Click the Select Multiple Items checkbox to select
multiple countries from the list. You can add more fields to the Report Filter area for more advanced filtering.
You can also filter the table using the row and column filters. To sort the data, just right mouse click on one of
the values that you want to use in the sort and choose the required sorting option. The image below shows a
sort being applied to the values of the product category field. You can group any numeric field. Grouping is
commonly applied to date and time fields. For example, dates can be grouped into months, quarters or years.
Specify start and end dates to group and the interval to group by. You can group a field by more than one date
or time period. To group by weeks, select days and enter 7 in the Number of days box. The Pivot Table is
grouped as specified. In this example the table was grouped by months and years. A new field called Years has
been added to the field list. This field can be used in further analysis with the Pivot Table. In the image below
the Years field has been added to the Columns area. Refreshing a Pivot Table If changes are made to the
source data, the Pivot Table needs to be manually refreshed. It does not update automatically. To refresh a
Pivot Table, click the Refresh button on the Analyze tab. Use the list arrow to refresh all the Pivot Tables in
the workbook. Report filters would appear on the Pivot Chart making is easy to interactive with and different
data selected on the fly. Click the PivotChart button on the Analyze tab of the Ribbon. Select the chart you
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want to use from the dialog provided. Different chart types are displayed down the left, sub types along the top
and a preview is shown in the main part of the dialog. The Pivot Chart appears in the worksheet with the
PivotTable. Use the tabs on the Ribbon to work on your PivotChart further. If you have found this learn Pivot
Tables tutorial useful, why not view more Pivottable tips.
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Excel Pivot Tables help you take a table (or list) of data and then create a report from it, instantly. For eg. you can take a
bunch of sales data and then create a report on region-wise sales performance by Product.

Wrapping up Pivot Table History Pivot Table feature as a program was first introduced to business houses by
Lotus throughout the year In the year , Steve Jobs saw the program and immediately ordered to develop it for
its then-new NeXT computer platform. Finally, this program was added to its NeXT platform in the year A
version for Windows was introduced in the year After that, pivot table has become the most powerful weapon
for a data warrior! Or, are you an intermediate level user of Excel and do you find it hard understanding the
features of Pivot Tables? Learning the basics of Pivot Tables is really an easy and fun thing! Start learning it
today, I can guarantee that, if you are like me, you will finish it today! So, just start learning Excel Pivot
Tables today! Why is Learning Pivot Table Important? Cortana, the data processing Engine of Bing, made a
perfect record, predicting every match correctly in the World Cup Cortana analyzed, manipulated,
summarized every bit of data that could be collected about players, venues of the games, coaches,
environments and much more. If Cortana used its capability in sports betting, it could earn billions of dollar in
just one month! Data is taking over the world. So analyzing, manipulating, and summarizing data in the
shortest possible time has become the most demanded job nowadays. And data analysis without Pivot Table?
Yes, possible, but while Pivot Table can make a report in just 5 seconds, you might need 5 valuable hours to
prepare the same report. Life without pivot table Take a look at this video and get a feel of the days when there
was no pivot table! Life after pivot table Here are our lives, lives with Excel Pivot Table feature. Tighten your
seat belt to become a data scientist! I have divided this Pivot Table guide into two parts. In the first part,
Introducing Pivot Tables, I shall just introduce you with Pivot Table, and in the second part, Analyzing Data
with Pivot Tables, I shall use a good number of examples to make the learning handier.
Chapter 8 : Video Lesson: Advanced Pivot Tables â€“ Round 1 | Excel Exposure
Pivot tables advanced tutorials will help us to deal with advanced uses of pivot tables. We will see what Pivot cache is,
understanding Pivot tables underlying data, data source, filters and page fields, rows fields, columns fields and values
fields in Pivot tables.

Chapter 9 : Excel Pivot Table Tutorial: Ultimate Guide to Creating Pivot Tables
PivotTables are one of the most useful tools in Excel. They allow you to easily summarise, examine and present a
complex list of data. This blog post explores 5 advanced PivotTable techniques.
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